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Partl1.

Introduction

The Kansas State Department of Education (KSDE), with funding from a grant awarded through the
Federal Safe and Drug-Free Schools program, has created a system for entering, storing, maintaining,
and analyzing data related to school incidents resulting in disciplinary action(s) for students. This
system, the Kansas Discipline Incident System (KAN-DIS), consists of an online tool for schools and
districts to use for entering information on individual incidents, including time, location, type of
incident, student(s) involved, non-student(s) involved, and disciplinary action taken. The tool will
also allow school and district administrators to see summaries of the data entered, and submit
required data to KSDE in fulfillment of State and Federal reporting requirements.

Purposes

The purposes of the Kansas Discipline Incident System (KAN-DIS) are as follows:

e To provide a free, useful tool to schools and districts in which they can maintain information
on a wide variety of discipline-related incidents.

e To facilitate accurate and timely reporting of discipline incidents as required by Special
Education (IDEA) and No Child Left Behind (NCLB).

e To lay the groundwork for the analysis of data regarding the relationship between discipline
incidents and academic performance, special education status, demographic data, and other
variables.

Required Incidents and Reporting

All accredited public schools must report the required incident data via KAN-DIS. All state or special
purpose schools who receive IDEA funding are required to report their incidents via KAN-DIS as well.
Use of the KAN-DIS is optional for private schools, as their data is not required for State and Federal
reporting purpose. However, private schools who receive funding for providing services to special
education students may be required to report discipline incidents only in the IDEA report or the
Emergency Safety Interventions Report for all students. Schools/districts are required to report the
following incidents:
1. All students, report any incident involving violence, weapons/ firearms, and /or substance
abuse (including drugs, alcohol, or tobacco) even if no action was taken by the school.
2. For IDEA Students...
a. Report all ISS, OSS, and EXP of at least one school day for all disciplinary reasons
that resulted in a disciplinary removal from the student’s current placement.
3. For Non-IDEA Students...
a. Report all ISS, OSS and EXP due to violence, weapons/firearms, alcohol, or substance
abuse of at least one school day.
b. Report all ISS, OSS, and EXP if the student was removed from their regular school
program for the remainder of the year of longer for any disciplinary reason.

KAN-DIS is designed to record all of the types of incidents mentioned that are necessary for Federal
reporting related to No Child Left Behind (NCLB), Safe and Drug-Free Schools (SDFS), and Special
Education (IDEA). The system also accommodates many incident types and disciplinary actions that
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are not required for Federal reporting purposes. This design allows KAN-DIS to be used as a school
or district’s comprehensive, all inclusive Discipline Information System.

In many sections of KAN-DIS, schools and districts may choose to report only at a primary, category
level, or to report at a more specific, subcategory level. For example, when reporting the location of an
incident, schools can simply indicate whether the incident occurred on-campus or off-campus.
Alternatively, schools can choose to report that the incident was in a specific on- or off-campus
location, such as a classroom, stadium, cafeteria, school-sponsored transportation, etc.

The categories, definitions, and fields required for KAN-DIS system will be updated on an annual
basis to comply with federal reporting requirements and to integrate any changes suggested and
agreed upon by the application users in Kansas and KSDE.

The table below represents the incidents that must be reported to KAN-DIS, and the incidents that are
optional for KAN-DIS reporting.

Action Taken | Student Type of Incident
Violence Weapons | Substance | Other
Abuse
In School IDEA X X X X
Suspensions Non-IDEA #
Out of School | IDEA X X X X
Suspensions Non-IDEA X X X ¥
Expulsions IDEA X X X X
Non-IDEA X X X *
Other IDEA X X X *
Non-IDEA * # * *
X=required
*= report the incident only if the action taken by the school was for the
remainder of the school year or longer
#= report the incident only if the weapon used was a firearm
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How Data Is Submitted to KAN-DIS

Discipline data is entered into KAN-DIS in one of three ways:

1. Individual Incident Entry: online data entry on an incident-by-incident basis using the long
form incident wizard,

2. Individual Incident Import: a batch file upload process from your SIS Vender where incident-
level discipline information is exported from the school or district’s local student information
system (SIS) into a file that is then uploaded to the KAN-DIS system, or

3. NCLB Summary/IDEA Student Level Reporting: aggregated incident entry only on an interface
within KAN-DIS similar to the NCLB Discipline Report application used in previous years.

a. Emergency Safety Intervention Reporting: The use of Emergency Safety Interventions is
reported quarterly, and an incident must be reported in the quarter it occurred. (For
more information regarding the Emergency Safety Intervention Report in KAN-DIS
consult the Quick-Start Instructions for the report on the KAN-DIS project website at
www.ksde.org/kandis under the “Documents” tab.)

Once data is entered into KAN-DIS, it must be reviewed and approved at the school administrator-

level. School administrators are responsible for officially submitting the required
incident data to KSDE.

KSDE will only be able to view the incident data after it has been verified, approved,
and submitted to KSDE by the school administrator, KSDE will only have access to the
aggregate totals (not individual incident information).
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Terms and Definitions

Meaning
The No Child Left Behind federal legislation signed into law on
NCLB
January 8, 2002.
FBI Federal Bureau of Investigation
KBI Kansas Bureau of Investigation
NCES National Center on Educational Statistics
SDFS Safe & Drug Free Schools
GFSA Gun Free Schools Act
IDEA Individuals with Disabilities Education Act (Special Education)
KAN-DIS | Kansas Discipline Incident System
Student Information System. A software application that administers
SIS and maintains student information, such as enrollment, scheduling,
attendance, accounting and grade reporting in a district/school.
Incident A school matter that results in disciplinary action(s) for student(s).
ISS or OSS | In-School-Suspension or Out-of-School Suspension
Vieti A victim is someone who was harmed in some way as a result of the
1ctim ..
incident
An offender is an individual who committed the incident resulting in
Offender . . .
disciplinary action.
EXP Expulsion
PBR Principal’s Building Report
PBS Positive Behavior Support
The Emergency Safety Interventions Report will record incidents of
Enéeli.gency seclusion and restraint for all students. Consult the Quick-Start
I atety Instructions for the Safety Intervention Report on the KAN-DIS
ntervention . . . « »
Report project website at www.ksde.org/kandis under the “Documents” tab

for more information.
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KAN-DIS User Level Definitions

User Level Defined Roles/Responsibilities Approval Privileges
School Data e Create, modify, and delete an incident e Submit incidents for
Entry in the “In Progress” status for their approval
school. e Cannot approve incidents
e Access individual incident summary e Cannot submit school level
reports, import batch files, and export aggregate reports.
files for their school.
e View and edit aggregate reports for
their school.
School Same as School Data Entry plus: e Approve individual
Administrator* | e Create, modify, and delete any incident incidents
in the “Pending School Approval” e Submit school level
status for their school. aggregate reports to KAN-
e Return incidents to “In Progress”. DIS
e Can permanently remove deleted items | e Return incidents that have
from the Recycle Bin. been submitted for School
e Can view, edit, or submit school level Approval to “In Progress”
aggregate reports.
School Read e To view reports and incidents entered e None
Only for the selected building.
District Data Same as School Data Entry plus: e Submit incidents for
Entry e  Access individual incident summary approval
reports, import batch files, and export e Cannot approve incidents
files for any school in their district. e Cannot submit school level
e View and edit school level aggregate aggregate reports.
reports for any school in their district.
e  Access Report Submission Status
Report for their district.
District e Review (read) any incident at any level | e Approve incidents (if
Administrator*® of the approval process, but cannot allowed by their district)
create, modify, or delete incidents. e Return incidents that have
e  Access individual incident summary been marked “Approved at
reports for students at any school in the School level” to “In
their district. Progress”
e  Access Report Submission Status e Return incidents that have
Report for their district. been submitted for District
e Review (read) school level aggregate Approval to “In Progress”
reports. e Cannot edit or submit
school level aggregate
reports.
District Read e To view reports and incidents entered e None
Only at a District Level.

* Depending on the approval process established for your district these roles and access privileges

may change.
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System Requirements

KSDE supports the following Browsers

Operating Browser | Browser Version
System

Windows 7 IE 7.X

Macintosh Firefox 3.6

Registering

NOTE: You may want to skip this section if you have used the KAN-DIS system before, or if you already
registered for access to the KAN-DIS system.

Individuals who do not have access to KSDE web applications need to register. Use the following web
address: https://online.ksde.org/authentication/login.aspx. At this website, click on the Register
button, as shown below in red.

state department of
Education

s

User Name:

Password:

KSDE applications support Internet Explorer 7.x and later for Windows and Firefox 3.6 and later for Macintosh.

</

Need help?  Click on the help icon for a series of Flash tutorials about the User Login.

Forgot Your Password?

' If you have not yet registered to have an individual login and password for accessing KSDE web
9 applications, click here to register.

On the Registration page, enter the required information. Be aware that the buildings and districts
that you have access to depend on what is displayed in the “Building” field on the web applications
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registration page. For example, if you will be submitting and viewing data at the district-level, select
the “All Buildings” option under the “Building” field. If you will be submitting and viewing data at the
building-level, select the appropriate building.

TIP: Do not use spaces when defining your User Name login ID. When creating your password keep in mind
the password requirements shown on the screen. You will need to remember the User Name ID, password,
security question/answer, and birth date that you entered. KSDE does not store this information for you.

KSDE User Registration Form
Back to Login Page

* Indicates required field.

Please enter your business contact information:

First Name:” Last Name:”

Phone #:* Email Address:"

Please select the crganization and building that you belong [

Organization: usp 220 Ashiznd - Building:

e

Please enter a user name and password.

User Hame:” Password:”

*
Please reenter your password:

Flease enter & password that contasins st lesst 8 charscters and at least one uppercase letter, one lowercase letter, and one number or special character. Do not use the
characlers "&", "#", "<" or "=

When you have completed all required information on the registration form, click the “Submit”
button at the bottom of the screen.

If all data on the registration form is valid, you will get a message that says “Thank You for
Registering”. The registration request will be forwarded to the district superintendent for approval.
You will receive an email when your access request is approved and your username and password are
ready for use.

Individuals who already have access to KSDE web applications can use the Manage My Account
option to add the KAN-DIS Report to their list of applications. As with all KSDE web applications, the
district superintendent will receive a request for approval before access is granted.

To add the KAN-DIS to your list of available KSDE web applications:
e Login on the KSDE Web Applications page
e Click the “Manage My Account” link
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e Check the box in front of KAN-DIS (current year)
e Select your access level (school or district)
e Click “Submit”

Your request will be sent to the district superintendent for approval. When approved, you will receive an

email indicating that you can access the KAN-DIS.

TIP: If you forget your KSDE web applications password, click on the link that says “Forgot Your Password?”
on the Authentication screen. You will be prompted to supply the answer to a security question (you entered it
when you originally registered), type in your birth date, and enter a new password. If your security question
answer and birthday match what you originally entered when you registered for KSDE web application access,
then your new password will be activated. Keep in mind that KSDE does not know your password, so you are
responsible for managing and remembering it.

Logging into the KAN-DIS Report

KAN-DIS, like the other KSDE web applications, is available on the KSDE Authentication page. To access the
KAN-DIS, enter your username and password on the KSDE Web Applications page
(https://online.ksde.org/authentication/login.aspx). The user will see the KAN-DIS Report on his/her list of
approved KSDE applications (example list shown below), and he/she will need to click on the application to
open it.

Click a link below.

1.ARRA LCP System
2.Assessment and Accountability Communications
3. AYP/QPA Accountability
4.Board Materials
5.BOE Reports
6.Corrective Action Plan
7 .Directory Updates
8.Dropout/Graduation Summary Report
9.EDCS
10.K-Para System Kan E]i5 201 4
lem e _
13.Measurable Objectives
14.QPA Quality Criteria Collection

Manage My Account
Logoff

System Maintenance Notices

© 2005 Kansas State Department of Education, All Rights Reserved.
Help Desk: (785) 296-7935
Front Desk: (785) 296-3201
FAX: (785) 296-7933
120 SE 10th Avenue
Topeka, KS 66612-1182

All sessions with this server are subject to the KSDE Use Policy and will be monitored and logged. Disconnect
now if you do not consent to having your actions monitored and logged, or if you do not agree to comply with
the KSDE Use Policy.

NOTE: Some of the applications may be grayed out. This means that they are either not active applications, or
that you have not yet been approved for access to those applications. Additionally, the numbering of
applications is unique to each individual user.
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If you are a district level user, you will be prompted to select a building, and then click OK (shown
below). All other users will go directly to the KAN-DIS main screen for their school.

partmant
Education

File» View? Options® Helpb Click here for d

Building Selection Please Select a Building

It has been determined that you have a
district-level user type. The Kansas

Djscip"ne Incident System requires that r Cornerstone Alternative Charter ngh School
you enter data at the school-level. In order r :
to continue, you must select a building Galena Dist Cherokee Co
from within your district that you want to 3 )
view or edit discipline incident data for. Calena High
(" Galena Middle School
(" Liberty Elem

¢ Spring Grove Primary Center
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KAN-DIS Main Screen

Across the top of the KAN-DIS main screen the user’s username, user level, district and building
information are displayed.

nansas " \.
Ed upl:atjon }

My User Name: training01a My User Type: SchoolAdministrator My District ID: TDOO1 My Building ID: TO01 - TOO1

File» View» Options?» Help)

ke View} Options b File-The file button brings up a menu where

1] New Incident you can enter a new incident, access your most

Recent Incidents b recent incidents, or log out of KAN-DIS.

@Ln:rg Cut
LE Fending School App

3

File ®  Wiew k  Cptions » Helpk
@lencidents

My Inc

v éﬂﬁ!epnﬂ:s

View—The view button brings up a menu
where you can view incidents that have

SIE8 1 Blarchive Reports been entered into the application, manage
= Hllstudent History Report the aggregate NCLB/IDEA reports or
e — generate reports.

Options—The options button brings up a
menu where you can import a file from
your SIS by clicking on “Import Data” or
E}Impm‘t Data change the approval process settings for

File® Viewr Options®» Helpk

My Incidents

& Approval Processin your di.strict by clic;king on “Approval

=l E‘{.:‘: Incidents - , CJLE,FL_. J Processing.” The options available under

7| In Progress this tab depend on the user’s level of
access.

sk 3
' H:lpq Help—The help button brings up a menu
B of help resources, including the KAN-
Kan-Dis Users Guide DIS User’'s Guide and links to the
el Definitions frequently asked questions on the KAN-
e DIS project website.
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The Tool Bar above the list of incidents allows the user to create new discipline incidents, search for
previous incidents, and submit incidents for approval. You may also remove discipline incidents.

El’llﬂa‘\illl’l%/

My User Name: jpricel

My User Type: School Administrator

My District ID: KSDE My Building ID: M&
File »  ViewP® Options® Helpk

My Incidents

1 New |i| 2 Remove |3 Return || & Approve |} Click here to selectavear 2010 § | (3] Search
=1 €4 Incidents - joricel
L7 In Progress Drag a column header here to group by that column
L& Pending School Approval

=] 0 B! incident Title Date School Year Cate Created
& Approved

&) Deleted Items

Created By Dat

Incident Folders—

The folder name will bring up

an explanation box to appear. These
folders allow the user to track where an
incident is in the approval process.

My User Name: training0la

File ®» VWiewk Optionsk Helpk

My Incidents
= €4 Incidents - trainin

L/| In Progress Drag a column header here to grou
| 4| Pending School Approval =

= Inddents that reguire some form of action by you beﬁ::j
t 15

i}i Approve they can be approved for submission to KSDE.

DT OPCTT T Py

{a) Deleted Items

|_.__1

= [T Broken Nose 8/15
= [T Broken Nose Augl5
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w =
Atatm dapartriant of
Education

My User Name: training0la My User Type: SchoolAdministrator My District ID: TDOO1 My Building 1D: TOO1 - TOO1

File »  Viewk Options» Help}
Step :: Start 0T . — — :
Step Details = @ || &G |skip To: [ Select a Step Hile

Welcome to the Discipline Incident Wizard

‘Welcome to the Incident Wizard. The
Incident Wizard will aid you in

creating/editing Incident records and This wizard will provide an interface for entering discipline incident information in a step-by-step process.
the varicus subsats of data that Each step of the wizard will provide a different description, contained in the panel to the left of the wizard
accompany Incident records (e. g. that will inform you how to successfully complete the step you are currently on.

Individual and Incident Type
records). This section of the page,
left of the Incident Wizard content
pane, will contain a description of
each step, as well as actions that can
be taken on this particular step,
required data elements, and links to
other K5DE information that may help
you when creating /editing an You may click Next when you are ready to start the wizard process.
Incident record.

The toolbar abowve the wizard will allow you to Save, Cancel, or Delete and Incident at any step of the wizard
process and the main menu will be accessible at any point during the wizard process to allow you to
navigate away. Be aware that changes you make to a new incident or an incident you are editing will not be
sawved unless you Save or move on to the next step of the process. Try to save frequently in order to avoid
loss of data.

Other Notes

‘When you are ready to begin the

Incident Wizard process, click next.

Also note that help information Mext
related to the Toolbar controls can

be viewed by clicking Help. You may

return to the My Incidents list at any

time by clicking the Homeicon on the
toolbar, but be aware that by clicking
thic hutton worazloce tha

D

Discipline
Incident Wizard

Step by Step Instructions —By Click Next to begin

starting the wizard, the folders are no
longer viewable; the left window pane
has been replaced with a description of

entering a new
discipline incident.

each step.
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Part II
Reporting Data

Step 1: Time and Location Screen

The time and location screen (shown below) records the time and location in which the incident
occurred as well as the type of incident that occurred.

My User Name: jpricel My User Type: School Administrator My District ID: KSDE My Building ID: NA

File» Wiew® Options® Helpk

Step :: Incident

| & @ |8 skipTo:[Step 1 - Incident 9
Required Figlds Incident Details
® Dare
* Incident Title
* Time Croup Identifying Information
& Location Group Date: l—GZ-'GS-'EU‘IU j
botd font Thess filds s be fled freldent Ttele: Brokien Nose
hefore clicking Save or Next Time: |09:40 AM
View the Toolbar Help for further School Year 20103
mfﬂrmann!ﬂ on how the toolbar controls Time of Day Inform g . i
interact with this step. Begln enterlng the
Time Group: Jlo Answier = information from the
incident into the wizard.
SChOOl Year defaults to Time Classifier: [No Answer =l Only the date. title. and
the current school year. location group are
I required. Required fields
appear in bold font.
Location Information
Lecation Group: | Mo Answer j

As you scroll down the screen, you will see drop down boxes that will allow you to enter more specific
information about the incident. Remember: only the fields that appear in the left window pan (circled
in read) are required by KSDE.

When you give the incident a title, make sure it is unique and easy to remember. Using the date of the
incident in the title is recommended.

____________________________ 9
| Do not use any student identifiable information such as names, initials, |
| or state ID numbers in the title. |

| In the example above, the title contains the date that the incident occurred and a |
description of the incident; it does not include any student information such as |
names or student state ID numbers. |
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Step 2: Incident Type Screen

After entering the basic incident information, you will be asked to select an incident type. A drop
down box will allow you to select the specific incident type. You repeat this process until all of your
incidents have been entered.

[ 4 o Y m— = - -
Kansas —
Education -

My User Name: training0la My User Type: SchoolAdministrator My District 1D: TDOO1 My Building 1D: TOO1 - TOO1

Education

File® View» OCptiocns®  Helpk
Step :: Incident Type List S = . — - N =
Step Actions || || '@ || & |skipTo: | Step 2 - Incident Tg,-pesj RN

Incident Type Records for this Incident

* Create a New Incident Type -

Click the New Incident Type :
button to create a new Incident No incident ty y - o 51T T T, (B e (e e . " — CIICk neXt once
Type record for this Incident. o incident types have been saved for this incident. Click New Incident Type to create a new inciden] . .

+ Delete an Incident Type - You the 1nCIdeI1t type

may select multiple or single rows
in the table and use the Delete
key on your keyboard or click the
Delete button on the toolbar to
delete that record. Hold down the

Note: At least one incident type is required per incident.

has been selected.

CTRL key to select multiple rows.
* Next - Click the Next button to
continue to the Individual List
step.
* Previous - Click the Previous
button to return to the Incident

MNew Incident Type

Previous Mext

Dietail step.
Incident Type Group: INo Answer :I
e You will need to select
Incigent TYPE | Weapons an incident type from
Threat .
Alcohol-Related the list.
Drug-Related
Tobacco-Related
Incident Type Asrson
Description Behavior
Forgery
Gambling
Theft
Sexual Offenses - Non-Violent
Trespassing
Truancy
fwww ksde orq /feedbad Vwasm 3
56-7535 | FAX. (785) 3 Inappropriate Computer Use s
th this server are subjed Cumulative M
tto having your action Dye Process Determination c
Other

Definitions for each incident type, actions taken, incident classifiers or weapons can be
found under the “Help” tab, click on Definitions.
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Step 3: Individual Screen

On the Individual screen you can enter information about the offenders and the victims involved in
the incident. You must add each individual involved by selecting “New Individual.” Note: you are
required to indicate an offender but reporting victims is optional.

Step = Individual List
Step Details

The Individual List step contains a table
that holds records representing
individuals invelved in a single discipline
incident. The records can be both
Offenders and Victims associated with the
incident.

Step Actions

# Create a New Individual - Click the
New Individual button to create a new
Individual record for this Incident.

s Delete an Individual- You may select
multiple or single rows in the table and
type Delete on your keyboard or click

|| & & % |skpTo [Step3-Indviduals ] i | @

Individual Records for this Incident

No individuals have been saved for this incident. Click New Individual to create a new individual.

New Individual

Previous MNext

First, you will need to indicate whether the individual you are adding to the incident is an offender or
victim. Use the Incident Role drop down box shown below to add a new offender or victim.

Individual Details

Idenfitying Informaticn

Incident Raole:

Individual Type:

H || @ | @ |i & skipTo:[Step3-Indviduals x| i| @

Victim
r

Offender j

=

Value determining whether the individual was an offender
or victim in this incident,

| One offender is required on each incident, however all victim

| information is optional. Please note if a victim is a current student, and a

state student identification number is provided, it must be a valid state I
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Entering an Offender

You will need to indicate the Individual Type using the drop down box. The only required fields on
this screen are the individual role and the individual type.

7 5\

Kansas ™ \_

My User Name: training0la My User Type: SchoolAdministrator My District ID: TDOO1 My Building I1D: TOO1 - TOO1

File ® View® Options® Helpk

Step = Individual Detail

|| & @ |i| % |skpTo: [Step 3 - Individuals x| | @) |

Required Fields
Individual Details

& [ndividual Role
& |ndividual Type
ldenfitying Information

R ired Fields - Victi =
. ln?:‘l:':r lelds - Victim Incident Role: I Offender j
Required Fields - Offender Individual Type: | Mo Answer j

» GCF5A Modification
= |DEA Disability
» Zero Tolerance Demagraphics

Required fields are always marked Find Student |

with bold font. These fields must be

filled in before clicking Save or Next. State Student [dentifier: I
View the Toolbar Help for First Name:
infarmation on how the toolbar
controls interact with this step. Last Name
Date of Birth: | ]
Cender: I Female j
Crade Level: | Mot Applicable j
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Entering an Action Taken

After entering all offender information, you will enter any actions taken with that offender. These are
actions specific to this offender. Action is a required field for every offender listed in an incident. If
there are multiple offenders, actions will be entered separately.

|G| @ |i| & skipTo:[Step3-Indviduals ¥| | @ Clicking here without first
Action Records for this Individual entering one action fOI' every
offender will create an error
when the incident is
Note: At least one action taken is required per offender. Smeitted.

N~ Click here to report an action taken
for this offender as a result of the Previous | Next |
incident
If you are entering an action, use the drop down box to select the action taken. The Action Taken is a
required field. If the Action Taken is “Other,” then a description of the action must be entered in the
action description field.

No Actions have been saved for this individual. Click New Action to create a new action.

n

If the action taken is a suspension or expulsion, the length in days also becomes a required field. You
must report in full days and not half days.

Entering a Weapon

After entering the Actions Taken for the individual, you will report if the individual used a weapon. If
a weapon is used, be sure that incident type screen, weapons has been chosen. This information is
specific to the individual. If you have an incident involving two offenders and only one used a weapon,
you only report the weapon on the one individual. If the incident did not involve a weapon you will go
to the next step.

I || @& || @ |i| % skipTo: [Step 3 - Individuals  +] i | @

Weapon Records for this Individual

Click here if no
weapon was used.

\/
Previous Next | >

Click here to add a weapon to NS _
this individual’s incident.

No Weapons have been saved for this Individual. Click New Weapon to create a new Weapon.
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Entering a Victim

The process for entering a victim is similar to the process for entering an offender. To add a victim
you must add a New Individual on Step 3. Similar to entering an offender, you must enter an incident
role and individual type for each victim. Use the drop down menu to change the individual role from
offender to victim.

Individual Details

Idenfitying Information

Incident Raole: | Victim j
Offe nder
Individual Type: Mictim

Then use the drop down menu to select Individual Type. Depending upon the victim type selected the
Demographic information field’s change. If the victim is a current student, you may choose to use the
Find Student Wizard to search for the student either by their current state ID number or their
information, but this is not required information for victims who are current or expelled/suspended
students.

TNCIJENt RoTe: | VICTm |

Individual Type: | Current Student j

Mo Answer \

Expelled/Suspended Student
Former Student

State Student 1o |otudent at Different School
Teacher

First Name: | Principal/Vice-Principal
Other Staff Member

Demographics

Last Mame

Parent
Date of Birth: |Jnknown
Other
Cender: | Female -
Crade Level: | Mot Applicable |
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Aggregate Discipline Incident Data

Report Selection Screen

Selecting “Reports” on the “View” drop down menu will open the Report Selection Screen. On this
screen, click on the name of the report to begin entering or editing the aggregate discipline incident
data. The left side of the Report Selection Screen indicates whether the report is incomplete, has been
modified by the user, or has been submitted to KSDE. Reports submitted to

KSDE are viewable but are unable to be edited.

The Report Status appears here. Once the

To open a status of a report indicates that the report has
report, click on been “Modified by User,” that table will no
the name of longer pull data from the individual incidents
the report. that have been entered in another portion of
This applies the application. This applies for all tables.
for all tables.
NCLB Reports: Report Status
Table 1 : Incident Count ‘Modified By User
Table 2 : Student Count Modified By User
Table 3 : Students Involved With Firearms Modified By User
; Table 4 : Firearm Qutcomes Modified By User
Z‘éﬁg';:g Table 5 - Educational Services Modified By User
IDEA reports Table 6 : Title IV ‘Modified By User
[ Submit. | Table 8 : Crime Matrix Modified By User
Table 9 : Behavior Incident Count Modified By User
Table 10 : Bullying Incident Count Modified By User
IDEA Reports: Report Status
Table 7 : IDEA Modified By User
! Emergency Safety Intervention Reports: Report Status
Submit all A ‘ =
Seclusionand | 2&clusion Report Modified By User
Restraint reports [Restraint Report Modified By User

Submit

| contact the KSDE Help Desk if you have any questions.

| Report each year, even if you have zero incidents to report. Please |
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NCLB Summary Reports

Table 1: Incident Count

For instructions on how to calculate the values reported in the NCLB/IDEA Summary Reports, see the
Training Examples for the Final Aggregate Reports in KAN-DIS 13-14 document on the KAN-DIS
project website (www.ksde.org/kandis)

To enter aggregate data in the table, select the Edit button on the left side of the table shown below in
blue. If you have no incidents to report in the table, select Submit Report at the bottom of the screen.
To return to the Report Selection Screen without submitting the report, select Back to Reports.

Table 1 : Incident Count

Report the cumulative number of incidents in which students were removed from their reqular education program for at least an entire school day for violence, weapons, alcohol, and/or drugs. Note
that "weapons” in this table includes both firearms and other weapons. This table differentiates between in-school suspensions, out-of-school suspensions, expulsions and other removals. Other
Removals include outcomes such as death, withdrawal, or incarceration. In cases where there is more than one discipline reason, for example, weapons possession and violent incident with
physical injury, report the most serious reason for removal as a result of the incident.

Use the following hierarchy for the most serious reason for the incident:

» Violence with physical injury Click on “Export” to open the

® Violence without physical injury

* Weapons possession (no mury) report as an Excel Spreadsheet
® Drugs

o Alcohol on all tables.

[] Export

- Violent Incident . .
Grade Illicit Drug Alcohol Weapon H p Incident Count Total Incident Grand Total
Injury No Injury

1SS (0S5 Exp./Other|155 0SS Exp. Other IS5 0SS Exp. Other 1SS 0SS Exp. Other| 1SS OSS Exp. Other 1S5 0SS Exp. Other
dergar‘[en 0,0 0 0 0 00 0 0/0]0 0 000 0 0|00 0 0|00 0

irst Crade | 0O
econd Crade 0
Edit Third Grade 0
Edit Fourth Crade 0
Edit Fifth Crade 0
Edit Sixth Grade 0
Edit Seventh Crade 0
Edit Eighth Grade 0O
Edit Ninth Grade = 0
Edit Tenth Grade 0O
Edit Eleventh Crade 0
Edit Twelfth Grade 0
Edit Mot Craded 0
it Total Incidents| 0

o o0 oo oo o oo o oo oo
o o0 oo oo o oo o oo oo
oo oo oo ooloo oo oo
oo oo oo oo|oo oo oo
oo oo oo oo oo oo oo
oo oo oo oo|oo oo oo
oo oo oo oo|loo oo oo
oo oo oo oo|oo oo oo
oo oo oo oo|oo oo oo
oo oo oo oo|loo oo oo
oo oo oo oo|loo oo oo
oo oo oo oo|loo oo oo
oo oo oo oo|loo oo oo
oo oo oo oo|loo oo oo
oo oo oo ooloo oo oo
oo oo oo ooloo oo oo
oo oo oo ooloo oo oo
oo oo oo ooloo oo oo
o o0 oo oo o oo o oo oo
oo oo oo oo oo oo oo
oo oo oo oo oo oo oo
oo oo oo oo|loo oo oo
oo oo oo oo|oo oo oo
oo oo oloooloo oo o oo

m
(=N

|Save|| Back to Reports ‘

To save the report to KSDE, select “Save”
button. To return to the Report Selection
Screen without submitting the reports, select
the “Back to Reports” button. You will follow
this process for all tables.
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After clicking on Edit, the user will be able to hand enter the aggregate data for each row. To save the
data that have been entered, click on Update. To avoid saving any data entered for that row, click on
Cancel. Repeat this process for each subsequent row.

.. . Violent Incident . Incident
Illicit Drug Alcohol Weapon - - Incident Count Total | Grand
Injury No Injury Total

IS5 | 055 | Exp. |Other 155 | 085 |Exp. Other 155 | 055 Exp. Other| 155 | Oss |Exp. Other| 155 | 0SS Exp. |Other 155 | 0S5 | Exp. Other
= o o o o o e o o e e e e o

Table 2: Student Count

To enter aggregate data in the table, select the Edit button on the left side of the table shown below in
blue. If you have no incidents to report in the table, select Submit Report at the bottom of the screen.
To return to the Report Selection Screen without submitting the report, select Back to Reports.

Table 2 : Student Count Incomplete

Report the number of students remowved from their regular education programs for at least an entire school day for violence, weapons, alcohol, and/or
drugs. Mote that "weapons® in this table includes both firearms and other weapaons. This table differentiates amonag in-schoaol suspensions, scut-of-school
suspensions, expulsion and other removals. Other Removals include cutcomes such as death, withdrawal, or incarceration. If a student has multiple
incidents for the same discipline reason, report the student only once per discipline reazon by the most serious Action Taken. If multiple students were
invalved in the same discipline incident, they should each be repaorted separately in this repart.

[] Export
Violent Incident Student
Grade licit Drug Alcohol Weapon : . Stud%r;i;:lount E?aunng
Injury No Injury Total
155 (055 |Exp.|Other|155 055 Exp. Other| 155 0S5 Exp. Other 155|055 Exp.|Other| 155 085 Exp. Other|155 | 055 Exp.|Other
dergarten| 0 |0 |0 | 0 |o|o| o] o |olo|lo| o oo | o [olofo] o |olo|o] o 0
Fccrade (0| 0|0 | 0o |oflo|o| o |ololof o fofolo|l o olofof o |ololo]| o
Ediz S=cand ololo| o |ojole| o |o|lo|lo| o |olo|o| o |ololo| o |olo|lol oo 0
Grade
EditThirdGrade |0 | 0 | 0 | 0 |o o] o | o |olo|o| o [ofo|lo| o [ofolo| o [ofof[o] o 0
EditFourthGrade| 0 | 0 |0 | 0 |o oo | o |o|o|o| o [o|e|o| o |ofelo| o [oo]o]| o 0
EditFifthGrade |0 | 0 | 0 | 0 |o|o|o| o |o|o|o| o |[o|le|o| o |[ofelo| o [oo]o]| o 0
Edit/SixthGrade |0 | 0 |0 | 0 |o oo | o |[oflo|o| o |ofolo| o fofolo| o folo[o] o 0
Ediz 2= venth ololo| o |ojole| o |o|lo|lo| o |olo|o| o |ololo| o |olo|lol oo 0
= |Grade
EditEighthGrade| 0 | 0 | 0 | 0 |o oo | o |[o|o|o| o |[o|e|o| o |[ofa o o [oo]o]| o 0
EditNinthGrade | 0 | 0 | 0 | 0 |o|o| o | o |o|o|o| o |[o|le|o| o |ofelo| o [olo]o]| o 0
EditTenthGrade | 0 [0 | 0 | 0 oo o | o [ofolo| o [oflofo| o loflefof o ofolo] o 0
Edic Eleventh ololo| o |ojole| o |o|lo|lo| o |olo|o| o |ololo| o |olo|lol oo 0
—|Grade
£z velfth ololo| o |ojole| o |o|lo|lo| o |olo|o| o |ololo| o |olo|lol oo 0
Grade
Edit/MotGraded |0 |0 | 0 | 0 |0 |0 o | o |o|olo| o [olo[o| o alelof o [ofo|o] o 0
Edit| 0% ool o |ololo| o |ojloflofo|ojo|lo| o ojolo| o |oloflo]| o 0
Students

Save | Back to Reports |

After clicking on Edit, the user will be able to hand enter the aggregate data for each row. To save the
data that have been entered, click on Update. To avoid saving any data entered for that row, click on
Cancel. Repeat this process for each subsequent row.
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Violent Incident Student

Grade Ilicit Drug Alcohol Weapon 8 8 Student Count Total E,?;nndt
Injury No Injury Total
155 | 055 Exp. |Other| 15% | O%5 | Exp. |Other 15% | OS85 Exp. Other 158 | 085 Exp. Other 158 | 055 Exp. Other| 155 | 055 Exp. Other
Edit dergarten| 0O ) 0 ) o ) 0 ) o ) 0 ) o ) 0 ) o ) 0 ) o ) 0 ) 0
Update Cancel Firstrade |[0 IU IU IU ] IU IU IU ] IU IU IU ] IU IU IU ] IU IU IU 0 IU IU IU IU
i ord o o 0 ) o o 0 ) o o 0 ) o o 0 ) o o 0 ) o o 0 ) 0
Grade
Edit Third Grade o o 0 ) o o 0 ) o o 0 ) o o 0 ) o o 0 ) o o 0 ) 0

Table 3: Students with Firearms

To enter aggregate data in the table, select the Edit button on the left side of the table shown below in
blue. If you have no incidents to report in the table, select Submit Report at the bottom of the screen.
To return to the Report Selection Screen without submitting the report, select Back to Reports.

Table 3 : Students Involved With Firearms Incomplete

Note that this table should only include weapons which are used as firearms. Report the unduplicated number of students who were involved
in an incident invalving a firearm by type of firearm, plus the total number of incidents. Any incident in which a student was found to have broughta
firearm to school or possessed afirearm at the school should be reported, even if the expulsion is shortened or no penalty is imposed. Any incidents in
which a student with disabilities {IDEA) brought a firearm to school or possessed a firearm at school should also be included, even if it is determined that
the incident is a manifestation of the student’s disahility. Report the total number of students by arade, total numhber of students overall, and total
number of incidents overall. “Please note that the total number of students reported in Table 3 should equal the total number of IDEA and Non-IDEA
students reported in Table 4.

[] Export

Grade Handguns|Rifles / Shotguns|Multiple Firearms|Other Firearms Total
dergarten o i} o

st Grade
dit/Second Grade
Edit|Third Grade
dit|Fourth Grade
Edit|Fifth Crade
dit|Sixth Grade
dit/Seventh Grade
Edit/Eighth Grade
dit/Minth Grade
dit| Tenth Grade
Edit|Eleventh Grade
dit{Twelfth Grade
dit/Mot Graded
dit{Total Students
dit|Total Incidents

l

l

Tl

m

m

Tl

m

al

m

ololoo|lolo|loo| o|loo|loo|lolo|lo
ololooloo|lo|o ool o|lolo|lo|lo
Do oo oo oo o ool o olo oo
e T T e T e T e T e T e T e T e e e
ololooloo|lo|o ool o|lolo|lo|lo

l

Save Back to Reports

After clicking on Edit, the user will be able to hand enter the aggregate data for each row. To save the
data that have been entered, click on Update. To avoid saving any data entered for that row, click on
Cancel. Repeat this process for each subsequent row.
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Grade Handguns Rifles / Shotguns|/Multiple Firearms|Other Firearms Total
Edit Kindergarten 0 0 0 1] 0

jrst Grade ] 0
Update Cancel|Sgcond Grade I I I II:I 0
; Third Crade a i}
Edit Fourth Grade ] 0 ] 0 ]
Edit Fifth Grade o 0 o 0 o

Table 4: Firearm Outcomes

To enter aggregate data in the table, select the Edit button on the left side of the table
shown below in blue. Please note: on the Firearm Outcomes report, Alternate Placement only applies
to Non-IDEA students who were expelled. Values for Alternate Placement for other outcomes cannot
be edited for this reason. If you have no incidents to report in the table, select Submit Report at the
bottom of the screen. To return to the Report Selection Screen without submitting the report, select
Back to Reports.

Table 4 : Firearm Outcomes Incomplete

Mote that this table should only include weapons which are used as firearms. Report the unduplicated number of students who were involved
in an incident involving a firearm by outcome and IDEL status. Alternate Placement or Mo Alternate Placement needs to be reported for Expulsions
involving Mon-IDEA Students only. Other Remowvals would include outcomes such as death, withdrawal, or incarceration. “Flease note that the tortal
number of students reported in Table 3 should equal the total number of IDEA and Non-IDEA students reported in Table 4.

] Export

IDEA Students Naon-IDEA Students Total Students

Action Taken Alternate Placement No Alternate Placement
Fulsion (Modified) 0 0
pulsion (Mot Modified) 0 0

Edit|/Other Remaowal
Edit|Other Discipline Action
Edit|Nao Action

dit| Total

(=R =Ri=RE=ylelle]
[l e Y e
[=R RN =R ]

Save | Back to Reports |

After clicking on Edit, the user will be able to hand enter the aggregate data for each row. To save the
data that have been entered, click on Update. To avoid saving any data entered for that row, click on
Cancel. Repeat this process for each subsequent row.

IDEA Students Mon-IDEA Students Total Students
Action Taken Alternate Placement Mo Alternate Placement
Edit Expulsion (Madified) a0 0 ] ]
Edit Expulsion (Mot Modified) 0 0 0 0
. Other Removal o 0 0 i
Dther Discipline Action Ii]— a0 IU_ Ii]—
9 Mo Action o 0 o o
Edit Total o 0 0 i

Save | Back to Reports |
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Table 5: Educational Services

To enter aggregate data in the table, select the Edit button on the left side of the table shown below in
blue. Please note: the Education Services Report will not pre-populate any incidents because removals
lasting the remainder of the school year or longer are not collected on individual incidents. If you have
no incidents to report in the table, select Submit Report at the bottom of the screen. To return to the
Report Selection Screen without submitting the report, select Back to Reports.

Table 5 : Educational Services Incomplete |

Report the number of students removed for disciplinary reason from their regular school program for the remainder of the school year or longer,
including Cun Free Schoals Actremowvals.

|| Export

Non-IDEA Students| IDEA Students Total Students
gvices Provided a o 0
_ 0 o 0

rvices Not Provided
Edit| Total 0 o 0

Save | Back to Reports |

After clicking on Edit, the user will be able to hand enter the aggregate data for each row. To save the
data that have been entered, click on Update. To avoid saving any data entered for that row, click on
Cancel. Repeat this process for each subsequent row.

Non-IDEA Students IDEA Students Total Students
Edit Services Provided ] 0 ]
Edit Services Mot Provided a i} a

T S .
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Table 6: Title IV Reporting

To enter aggregate data in the table, select the Edit button on the left side of the table shown below in
blue. Please note: the Title IV Report will pre-populate any students reported as exercising the Unsafe
School Choice Option or reported as truant on KIDS EOYA records. Students expelled for felonies will
have to be manually entered since felony information is not collected on individual incidents. If you
have no incidents to report in the table, select Submit Report at the bottom of the screen. To return to
the Report Selection Screen without submitting the report, select Back to Reports.

Table 6 : Title IV Incomplete |

The following informartion is required for Federal Title IV reporting. "Criminal felony offense” is defined as any felony against persons, including: Murder,
Aggravated Assault, Barttery, Criminal Threat, Hazing, Kidnapping, Robbery, Burglary, Stalking, Child &huse, Terroristic Threar, or sex crimes such as:
Rape, Aggravated Indecent Liberties with a Child, Sexual Battery, and Sexual Exploitation of a Child. "Truant™ is defined as any studentwith 3
consecutive unexcused absences, 5 unexcused absences in any semester, or 7 unexcused absences in a vear iwhichever comes first) initially
populated based upon EQYA submissions to KIDS. "Unsafe School Choice COption” is a provision of Federal Law allowing a student to transfer cutof a
school deemed “persistently dangerous.” Truancy and Unsafe Schoaol Choice Options are initially reported via the KIDS Collection System. *Please note
that the total number of "Students expelled for having been convicted of or adjudicated for a criminal felony offense” should not exceed the number of
Student Count/Student Count Total Expulsions reported in Table 2.

[] Export

Students expelled for having been canvicted or adjudicated for a criminal felany offense: i}
Students exercising the Unsafe School Cheoice Option and transferring to a different school within the district 0
Students truant this school year: 0

Back to Reports

IMPORTAMNT: The first row of this report must be hand entered using the Edit link. The remaining rows are populated automatically from EXIT and EQYA
recards submitted to KIDS. Before using the Edit link to add data to the first row, be sure thar all of vour KIDS entries for Truancy and Unsafe School
Choice are up-to-date. If you edit the report before completing your KIDS entries, subsequent records submitted to KIDS will not update automatically.
This may resultin incorrect or incomplete dara.

After clicking on Edit, the user will be able to hand enter the aggregate data for each row. To save the
data that have been entered, click on Update. To avoid saving any data entered for that row, click on
Cancel.

Table 7: IDEA

To add an additional incident, select Insert Record, shown below in blue. Additional incidents may be
added by filling in the date, ID, days suspended or expelled, and placing the appropriate checkmarks
in the drug, serious injury, weapon, hearing officer, conduct violation and services fields. For
explanations of each of these data elements, consult the KAN-DIS File Specifications Document.
Once the information has been entered for the incident, select Insert Record to save the record.
Repeat this process for each subsequent incident.

To edit data already pre-populated in the table, select the Edit button on the left side of the table (not
shown below). Please note: Approved individual incidents will pre-populate this report.
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Table 7 : IDEA Modified By User

Report all incidents invaolving IDES students that resultin an 155, 055 or Expulsion. Include individual studentinformation for all students invelved in an
incident that have an IEP far a disability at the time of the incident.

IMPORTANT: If vou use Individual Incident Data Entry or Individual Incident Import to enter discipline incidents, do not enter or edit incidents in the IDE4
report directly. If wou do, any subsequentincidents wou enter via data entry or impart involving IDEA students will not be populated inta the report, even
if they are in the Approved folder. Direct entry into the IDEA Aggregate Reportis intended for users who are not using Individual Incident Data Entry or
Individual Incident Import to enter discipline incidents involving IDEA students.

[] Export

. KIDS Student Serious |, Hearing Vielation -
dent Date D Drug Injury Weapon officer Conduct IS5 Days |055 Days EXP Days Services
Edit
12/9e/200@ 7706587371 2 - - - - o 3 o -
Delete
Insert Record I I - - - [l [l IU IU IU [l

Save | Back to Reports |

Incidents can be stored and managed in this report and once the Submission Window for the IDEA
reports opens, the Submit Report button will no longer appear grayed out and a school administrative
level user can submit the final report.

Table 8: Crime Matrix

The information is required for Federal Title IV reporting. Report the cumulative number of
incident(s) that a student was involved in any felony against persons, including: Murder, Aggravated
Assault, Battery, Criminal Threat, Hazing, Kidnapping, Robbery, Burglary, Stalking, Child Abuse,
Terroristic Threat, or sex crimes such as: Rape, Aggravated Indecent Liberties with a Child, Sexual
Battery, and Sexual Exploitation of a child.

My User Name: do462-da My User Type: District Administrator My District ID: D0462 My Building ID: 7254 - Central Jr-Sr High

File» View» Options» Help»

Table 8 : Crime Matrix Incomplete

Back to Reports

Table 9: Behavior Incident Report

For instructions on how to calculate the values reported in the NCLB/IDEA Summary Reports, see the
Guidance for Submitting NCLB/IDEA Reports in KAN-DIS 2013-2014 document on the
KAN-DIS project website (www.ksde.org/kandis).

To enter aggregate data in the table, select the Edit button on the left side of the table shown below in
blue. If you have no incidents to report in the table, select Save at the bottom of the screen. To return
to the Report Selection Screen without saving the report, select Back to Reports.
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Table 9 : Behavior Incident Count Meodified By User

Report the cumulative number of incidents in which students were removed from their reqular education program for at least an entire school day for
academic mizsconduct, disruptive behavior, obscene behavior, lying, and/or other behavior. This table differentiates between in-school suspensions,
out-of-school suspensions, expulsions and other remowals. Other Removals include outcomes such as death, withdrawal, or incarceration. In cases
where there is more than one discipline reason, for example, chscenes possession and violent incident with physical injury, report the most serious
reason for remowal as a result of the incident.

Use the following hierarchy for the most serious reason for the incident:

& Academic Misconduct
& Disruptive Behawior

® Obscene Behavior

* Lying

& Other Behavior

[:€] Export
Academic Disruptive . . Incident Count Incident
Misconduct Behavior Obscene Behavior Lying Other Total Grand Total
155 OS5 | Exp. Other| 155|088 Exp. Other|155 055 Exp. Other|1SS 0SS Exp. Other| 158 0SS Exp. Other| 158 |0SS | Exp. Other
Edit| 0 o o o ] o o o o ] ] ] o ] ] o o o o o ] ] o o o

[ Save l [ Back to Reports

After clicking on Edit, the user will be able to hand enter the aggregate data for each row. To save the
data that have been entered, click on Update. To avoid saving any data entered for that row, click on
Cancel.

Incident
Academic Misconduct | Disruptive Behavior Obscene Behavior Lying Other Incident Count Total | Grand |-
Total |~

155 | OS5 | Exp. Other 155 | OS5 |Exp. Other 155 | OS5 | Exp. [Other 155 | OS5 | Exp. |Other 155 | OS5 Exp. |Other IS5 | 055 Exp. |Other|
Edate(ancelUUUUUUUUUUUUUUUUUUUUUUUUU

Table 10: Bullying Incident Report

For instructions on how to calculate the values reported in the NCLB/IDEA Summary Reports, see the
Guidance for Submitting NCLB/IDEA Reports in KAN-DIS 2013-2014 document on the
KAN-DIS project website (www.ksde.org/kandis).

To enter aggregate data in the table, select the Edit button on the left side of the table shown below in
blue. If you have no incidents to report in the table, select Save at the bottom of the screen. To return
to the Report Selection Screen without saving the report, select Back to Reports.

30 | Kansas Discipline Incident System Version 2.0


http://www.ksde.org/kandis

Table 10 : Bullying Incident Count Modified By User

Report the cumulative number of incidents in which the student(s) was removed from their regular education program for at least an entire school day for
physical, cyber, verbal and/or relational bullying. This table differentiates between in-school suspensions, out-of-school suspensions, expulsions and
other removals. Other Remowvals include outcomes such as death, withdrawal, or incarceration. In cases where there is more than one discipline reason,
for example, physical bullying and verbal bullying, report the most serious reason for removal as a result of the incident.

Use the following hierarchy for the most serious reason for the incident:

Physical Bullying
Cyberbullying
Verbal Bullying
Relational Bullying

|| Export
Physical Cyber Verbal Relational Total Incidents |Incident Grand Total
155|055 Exp. Other| 155 /OS5 Exp./Other| 158 OS85 Exp. Other| 158|055 Exp. Other 155 OS5 Exp.| Other
Edit| 2 o u] o 4 o u] o 1 o u] o 3 o o] o 10 0 o] o 4
Save Back to Reports
Incident

Physical Cyber Verbal Relational Total Incidents Grand
Total

155 | 055 Exp. Other| 155 | 055 Exp. Other| 155 | 055 Exp. Other 155 | 055 | Exp. Other

155 | 055 | Exp. Other
0 1 0 0 0 3 0 0 0 10 |0 0 0 4

QdateCanceI20[]U400
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Emergency Safety Intervnetion Reports (Seclusion and Restraint)

To access the Emergency Safety Intervention Reports (Seclusion and Restraint), log into the KAN-DIS
2012 application as a school data entry or school administrator level user, go to the View link and
select “Reports” from the drop down menu.

Please note: The Emergency Safety Interventions Reports are stand-alone reports in the KAN-DIS
application and the Emergency Safety Interventions Reports will not pull any incidents entered
elsewhere in the KAN-DIS application. The Emergency Safety Interventions Reports should be
submitted by a School Administrator quarterly.

Emergency Safety Intervention Reports: Report Status
Submit all Seclusion Report Modified By User
Seclusion and ECLRION REpOr : Y

Restraint reports Restraint ReEDrt Modified BY User

Submit
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Submitting the NCLB/IDEA Summary Reports

Once all error messages are resolved for all reports and you have saved them, the reports will need to
be submitted by a School Administrative Level User. From the Reports main page, selecting the
“Submit” button, will allow you to submit all seven reports at one time.

NCLB Reports: Report Status
Table 1 : Incident Count ‘Modified By User
Table 2 : Student Count ‘Modified By User
Table 3 - Students Involved With Firearms ‘Modified By User
; Table 4 : Firearm Qutcomes Modified By User
z‘ét"_';';:g Table 5 - Educational Services Modified By User
IDEA reports Table 6 : Title IV Modified By User
Table 8 : Crime Matrix ‘Modified By User
Table 9 : Behavior Incident Count Modified By User
/ Table 10 : Bullying Incident Count ‘Modified By User
IDEA Reports: Report Status
Table 7 - IDEA Modified By User
] Emergency Safety Intervention Reports: 'Report Status
Submit all - 7 i >
Seclusionand | 2&clusion Report ‘Modified By User
Restraint reports [Restraint Report Modified By User

Please note: The Emergency Safety Intervention Reports must be submitted
separately from the NCLB and IDEA reports. Below are the due dates and each
quarter reports must be submitted, even if the numbers are zero.

Quarterly Reporting Dates

Quarter 1 Entry Dates:July 1, 2013 — September 30, 2013

Quarter 1 Submission Window: September 30, 2013 — October 15, 2013

Quarter 2 Entry Dates: October 1, 2013 — December 31, 2013

Quarter 2 Submission Window: December 31, 2013 — January 15, 2014

Quarter 3 Entry Dates: January 1, 2014 — March 31, 2014

Quarter 3 Submission Window: March 31, 2014 — April 15, 2014

Quarter 4 Entry Dates: April 1, 2014 — June 30, 2014

Quarter 4 Submission Window: May 15, 2014 — June 30, 2014
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A confirmation message will appear. Clicking “OK” will submit the reports and the reports will
become locked and no further edits will be allowed and no further incidents will populate onto the

reports.

My User Name: jpricel My User Type: School Admimitrator My District 10: 50¢C My Sullding 1D: N&

o Viewd et b Help»

NCLE Reports: Report Status

Modfhed By User

Submit &
NCLE and

\?/ By nomiting Tete reports 20 K50E, you e AJreeng Tat the dats contaned n Them 5 actrate.
{ O I Cancel I
Emergency Safety Intervention Reports: Report Status
Seclusion Report Modified By User
Restraint Report Modified By User

Final NCLB/IDEA Aggregate Reports

Schools can enter the summary data required for NCLB reporting via an online NCLB report interface
(similar to the one used in previous years but now it is located within the KAN-DIS application). The
school principal must sign off on the NCLB discipline report in order to submit to KSDE. These
schools will also have to enter the required student-level IDEA discipline data into KAN-DIS in the
IDEA discipline data table, or via the KAN-DIS online incident-level data reporting interface.

Please note: Only the school administrative level user will be able to view, enter, edit, or submit
the aggregate reports.

To access the Reporting interface in the KAN-DIS application, hover over the “View” link with the
mouse to open a drop down menu. On the drop down menu, select “Reports.”

My User Name: TesterQ1DLEHS My Use

File »  ViewP® OCpticns b Help b
o

éﬂRepcr‘ts

My Inci
3 g

IR

Drag a co

[ =)

& ;_-%HStLIElEnl‘HiSl‘C’-{REF:CT
i3

& Approved

&) Deleted Items

]

Hover over “View” with the mouse and select “Archive Reports” to open or save a PDF of the previous
NCLB Reports. Previous IDEA reports are not available as an Archive Report.
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] New || 2 Remove | | (3] Return || & Approve | { Click here to select avyear: 2008 |

Drag a colur

- Fil U0l %]
| ! in

Do you want to open or save this file?

eated

{ ror (8 Mame: Model.pdf
| | Type: Adobe Acrobat Document
From:  swviistest001

Open ] [ Save ] [ Cancel

I e | ‘while files from the Intemet can be uzeful, some files can potentially
a harm your computer. IF you do not trust the zource, do not open or
b zave this file. What's the risk?

IDEA Summary Report

Incidents can be stored and managed in this report and once the Submission Window for the IDEA

reports opens, the Submit Report button will no longer appear grayed out and a school administrative
level user can submit the final report.

To enter aggregate data in the table, select the Edit button on the left side of the table. If you have no
incidents to report in the table, select Save at the bottom of the screen. To return to the Report
Selection Screen without saving the report, select Back to Reports

Aggregate Report Submission Status Report

District level users have the ability to monitor the submission status of the aggregate reports for the
schools in their districts. To access the Submission Status Report, access the View menu on the KAN-
DIS Main Screen and click on Aggregate Report Status (shown below in blue).

My User Name: Tester04355uper
File »  View® Cptichs®  Helphk
‘E;&I'-I'-_,-' Incicdents
jﬂRepC'ts
ﬂ-ﬁ"chi:e Reports
éﬂStuclenr History Report

< Aggregate Report Status >

District Level Users may select to display All Buildings or one building from their district. The

information may be exported as Excel spreadsheet by clicking on the Export button (shown below in
blue).
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My User Type: District Administrator

My District ID: DO233

My Building ID: 0853 - Briarwood Elem

113 13 9 .
— Select “All Buildings” to view the Aggregate

All Buildings ‘ 1 buildi ; Jistri The status

Bentwood Elem .

Bentwood Elem gelport %aFES or all bui }lln%i In your 11{str1ct. columm will

Briarwood Elem elect a building to view the Aggregate Report Y :

Brougham Elem g . . gg g p lndlcate 1f the

California Trail Jr High Status for each building separately. report is

lg Export |pRsuits per Page: I 25 vI Report Type: IJ"“‘-” 'I Incomplet:ef has

District Buildjlfg Building Name _ Report ) Period Statu been modlfled

Olathe Morthwest High School Table 1 : Incident Count Incompl
CozZ33 0845 Olathe Northwest High School Ta::e 2: Stujent CoLmlI: 4 . Incomplete by User, or has
. . Table 3 : Students Inwvolwved Wit

D0233 0845 Clathe Morthwest High School . Incomplets b :
Fircarms een Submitted

Do0z233 0845 Olathe Morthwest High Schooal Table 4 : Firearm Outcomes Incomplete :

DCozZZ3 0345 Olathe Morthwest High School Table 5 : Educational Services Incomplete Reports are

o233 0545 Olathe Morthwest High Schooal Table & : Title IV Incomplete .

DO233 0845 Olathe Morthwest High Scheal Table 7 : IDEA Incomplete requlred to be

D0233 0845 Clathe Morthwest High School 22;;:' Education Seclusion 1 Incomplets Submitted even
- )

D0233 0845 Qlathe Morthwest High School 22;;:' Education Seclusion 2 Incomplete if the School had

Doz233 0545 Olathe Morthwest High School gz;;:l Education Seclusion 3 Incomplete no discipline

Doz233 0846 Regency Place Elementary Table 1 : Incident Count Incomplete . od h

Do0z233 0846 Fegency Flace Elementary Table 2 : Student Count Incomplete lnCI ents t ey

CozZ33 0345 Regencw Place Elementary -Friz:glaerrfs: studsnts Invalved with Incomplete are required to

Doz233 0546 FRegency Flace Elementary Table 4 : Firearm Outcomes Incomplete t

D0233 0846 Regency Place Elementary Tabkle 5 : Educational Services Incomplets I‘eI)Or .

Do233 0846 Regency Place Elem entary Takle & : Title IV Incomplete

Do0z233 0546 Fegency Flace Elementary Table 7 : IDEA Incomplete

Do0233 0846 Regency Place Elementary 22;;:' Educartion Seclusion 1 Incomplets

D0233 0846 Regency Place Elementary gs;;:l Educarian Seclusion 2 Incomplets

Do233 0846 Regency Place Elementary 22;;:' Education Seclusion 3 Incomplets

Do0z233 0547 Frontier Trail Jr High Table 1 : Incident Count Incomplete

Doz233 0547 Frontier Trail Jr High Table 2 : Student Count Incomplete

CozZ33 0547 Frontier Trail Jr High —Friarglair.’rfs: studsnts Invalved with Incomplete

D0233 o847 Frontier Trail Jr High Tabkle 4 : Firearm Qutcomes Incomplets

Do233 0347 Frontier Trail Jr Hiah Table & : Educational Services Incomplete

1224558758218 ..

Additional pages may be displayed by using the Results per
page feature or by selecting the next page number appearing

below the report list.

Using the Student History Report

To view a history report of a student’s incidents or to generate a report of all incidents of a particular
type, the View link will allow you to go to “Student History Report.” Only approved incidents will be
included in this report.

Click on the Search button and the Incident Search Criteria window. To generate a report for an
individual student, enter the student’s state student identification number. In order to generate a
report by incident type, select only an incident type from the drop down menu. The date can be used
to narrow the search parameters. Then select OK. Any incidents that meet the specified search criteria
will appear in a list form.

The user can view a particular incident by double-clicking anywhere on the incident. The search
feature pulls incidents from the In Progress folder, the Pending folder and the Approved folder.
Incidents appearing with a green icon to the left of the incident title are read only and must be
returned by an administrative user before you will be able to edit the incident.
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Correcting Errors in Individual Incident Entry

In addition to the Discipline Incident wizard error messages, KAN-DIS will notify you if have made an

entry error when you try to submit the incident for approval.

To submit an incident for approval, select the incident by placing a checkmark in the box to the left of
the incident title and then clicking on the Send button’s drop down arrow. On the drop down menu,
click SELECTED to submit the incident. Clicking ALL will submit all of the incidents in the “In

Progress” folder.

My Incidents
= B Incidents - jpricel

% In Progress

Pending School Approval
=

& Approved

@ Deleted Items

If there is an error in the incident, the incident will not be submitted for approval and will appear with
a red flag. This indicates there is an error in the incident. Opening the incident summary report will

| 2] New |i|.2Re e | (3 Senc - | N\Click here to select a vear: 2010 § | [ search |
All
Drag a column headegher lum
Selected
O[B! Incident Ti . Ca School Year Date Created Created By
one

= p INs Test RAGTT /20/2000 2010 12/20/2000 04:36 ipricel
[T % Brokgh Nose 02/02/20010 2010 02/03/201001:06 jpricel
Bgaflen Maose 02/03/2010 2010 02/03/2010 10:58 jpricel

provide a description of the incident.
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Welcome to the Discipline Incident Wizard

| &= Print || 3] Export |

Kan _D Inciderﬂclid here to export this report to excel. h

District ID Building ID School Year

TDOO1 TOO1 2009

Birthday Fight 8/25/2008

focal D owte ____ncident time__Reporer
KVNpcf3f3RQvYMP  8/25/2008 No Answer

MNo Answer

During School Hours @

Emors:

When an individual has an incident role of offender, Zero Tolerance must have a valid
value that is not 'No Answer. When an individual has an incident role of offender, IDEA
Disability must have a valid value that is not '"No Answer.',When an individual has an

Version 2.0

124
024
024



You can also open the incident by double-clicking anywhere on that incident highlighted below in
blue. A red error message will appear on the incident entry screens.

Drag a column header here to group by that column

i} ‘El ‘ ! Incident Title ‘Date ’S(ha-ol Year Date Created I(
= Drugs found in locker 0B/04/2008 2009 08/25/2008 03:30 Tl
| I” % Bullying in parking lot 08/08/2008 2009 08/25/2008 03:32 T
= Food fight 08/11/2008 2009 08/25/2008 03:29 Tl
=N Cafeteria Vandalism 08/13/2008 2009 08/25/2008 03:28 T

To open the incident to correct the error, you can either use the Select a Step... navigational drop
down menu to view one of the steps in the incident or use the Next button indicated below in red.

| (@[3 ][ sue ] Step 1 -ncider X\ o \

welcome to the Discipline In(id Select a Step I

pgto the step selected in the drop down. i

Step 2 - Incident T
| = Print || %] Export | \lgzgpgza -|2§:W3Ta|sypes A
Kan-Dis Incident Report jl

District ID Building ID School Year
KSDE NA 2010
Incident Name
Broken Nose
Locl 1
RvuytAABOgN09aQ  2/2/2010 09:30 AM Student
On Campus Cafeteria
TimeGroup |Time Classifier _ Time Description |Has Emors
During School Hours Morning Classes True
[
P —
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If the incident contains an error, an error description appears in red at the top of the screen.

| a5 [siap To: [ Step 1 - Incident

& LocationGroup must have a valid value that is not 'No Answer.'

Inc

ldentifying Information

:

: [03112/2008 £
Incident Title: |Fight at Football Game
Time:
School Year: 2008
Local Incident ID: [BePtOYrOkgilnT2

Statuszlln Progress j

Time of Day Information

TimeCroup:IND Answer j

Time CIassiﬂer:IND Answer j

Time Description:

Location Information

Location Group: | Mo Answer j
Mo Answer
On Campus
Location Classifier:
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Server Error in '/Authentication' Application.

A transport-level error has occurred when sending the request to the server. (provider: TCP Provider, error: O
- An existing connection was forcibly closed by the remote host.)

Description: An unhandled exception occurred during the execution of the current web request. Please review the stack trace for more information about the error and where it originated in the code.

Exception Details: System Data SqlClient.SqlException: A transport-level error has occurred when sending the request to the server. {provider: TCP Provider, error: 0 - An existing connection was forcibly closed by the

remote host.)

Source Error:

An unhandled exception was generated during the execution of the current web reguest. Information regarding the origin and

location of the exception can be identified using the exception stack trace below.

Stack Trace

[SqlException (0x80131904): A transport-level error has occurred when sending the request to the server. (provider: TCP Provider, error: 0 - An

System.
System.
System.
System.
System.
System.
System.
System.
System.
System.

System
System
System
System

Version Information

Data
Data

Data.
Data.
Data.
Data.
Data.
Data.

Data.
Data.

sqlClient.
SqlcTient.
sqicTlient.
sqlClient.
sqlcTient.
Sqiclient.
.5qlclqient.
.sqlcTlient.
Sqiclient.
sqlClient.
authentication.loginl.
authentication.loginl.
.Web.uz
Jweb.uI
.Web.u1
.Web.uz

sqlConnection.OnError(SqlException exception, Boolean breakConnection) +212
TdsParser.ThrowExceptionAndwarning(TdsParserStateObject statedbj) +245

TdsParserStateObject.writesni() +355

TdsParserStateObject.ExecuteFlush() +174

TdsParser.TdsExecuteRPC(_SqIRPC[] rpcArray, Int32 timeout, Boolean inSchema, SqlNotificationRequest notificationRequest
SqlCommand. RunExecuteReaderTds (CommandBehavior cmdBehavior, RunBehavior runBehavior, Boolean returnStream, Boolean asyn
sqlCommand.RunExecuteReader (CommandBehavior cmdBehavior, RunBehavior runBehavior, Boolean returnStream, String method,
sqlCommand. RunExecuteReader (CommandBehavior cmdBehavior, RunBehavior runBehavior, Boolean returnStream, String method)
SqlCommand.ExecuteReader (CommandBehavior behavior, String method) +211

sqlCommand.ExecuteReader (CommandBehavior behavior) +87

Login(String username, String password) in C:\inetpub\wwwroot\Authentication\login.aspx.vb:141

btnlogin_Click(0bject sender, EventArgs e) in C:\inetpub\wwwroot\Authentication\login.aspx.vh:87

.WebControls.Button.onClick(EventArgs e) +115

.WebControls.Button.RaisePostBackEvent(String eventArgument) +140

.Page.RaisePostBackEvent (IPostBackEventHandler sourceControl, String eventArgument) +29
.Page.ProcessRequestMain(Boolean includeStagesBeforeAsyncPoint, Boolean includeStagesAfterAsyncPoint) +2981

: Microsoft .INET Framework Version:2.0.50727.4241; ASP.NET Version:2.0.50727 4239

Correcting Errors on NCLB Summary Reports

If any report contains an error, an error description appears in red at the bottom of the report and the
corresponding cells in the report generating the error will appear raised and will be denoted by a red
asterisk. In this example, the Incident Count Total and Incident Grand Totals cannot be zero when an
OSS is reported for that grade level. Including a value in the appropriate columns will resolve the

error.

155

- _ Violent Incident . Incident
Illicit Drug Alcohol Weapon - - Incident Count Total | Grand
Injury No Injury Total

055  Exp. |Other| 155 | 055 | Exp. |[Other| 155 | 055 | Exp. Other 155 | Oss | Exp. Other 155 | 055 Exp. Other| 155 | 055 | Exp. |Other

PSP -au o o o o o o o o o o o o O o o o

Save

Back to Reports

any individual incident type, and may no e sum of all ISS.

orted for any individual incident type, and may not exceed the sum of all
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If this screen appears you will need to turn off all programs and restart your computer.

Individual Incident Import Instructions
Uploading a Batch File

To import discipline incidents entered into a school’s Student Information System (SIS), access the
Options menu on the KAN-DIS Main Screen and click on Import Data.

File ¥ Viewr Opticg elp b

My Incidents & Jimport Data

- ﬂhpprwal Processing
=l @ Incidents - seswmiwa

L7 In Progress
L% Pending School Approval
L 4| Pending District Approval [
< Approved
-| 5& state Reporting
[ WCLE Discipline Report
() Deleted Items

| Browse. |  Upload File |

I % Text File £ XML File

Provide a date range and select the “Retrieve Batch List”
button to see all previously imported batch files occurring
during the dates you have provided.

Uploaded Batch Information |

Begin Date |Tue Feb 12, 2008 End Date [Thu Mar 13, 2008 Retrieve Batch List |

Upload 1D Uploaded - Total {Correct/Errored Fatal Error

Details | Errors | 764 03/13/2008 102/102/0 END

Details | Errors | 763 03/13/2008 102/102/0 END

Errors | 762 03/13/2008 30/30/0 END
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Step 1: Select the type of file to be uploaded.

When importing a text file or XML file make sure that the appropriate file type has been selected in
the box under the File Browser field shown below in blue. Note: Failing to select the correct type of
file will cause the import to fail. Click on the Browse button to locate the file to be imported shown

below in red.

T R
Education

My User Name: Tester0101EHS My User Type: Schooladministrator My District ID: 00101 My Building ID: 0105 - Erie High Charter School

File» view» Options» Help»
@ Upload File

Uploaded Batch Information |

Begin Date |Sat Nov 22, 2008 End Date |Mon Dec 22, 2008 Retrieve Batch List |

Step 2: Select the file to be uploaded.

Clicking on the Browse button will open a new window. In this window, locate the file you wish to
import, select the file shown highlighted in blue below, and click Open shown below.

Look in: I@Sample Files j L] |‘=j< ER-

—

268. tt
= TestXmiFile_2Incidents_MoErrors3268. xml

ere fof

Upl

h Lis)

File name: IGoodB?BB.t:d j Open I >

Fies of type: ~ [All Fles () =l
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Step 3: Upload the file.

Clicking open will place the file’s name in the File Browser field. Check to make sure the correct file
name appears in the File Browser field. If the file name is correct and the correct file type is selected
in the box under the field, click the Upload File button.

IC:HDDcuments and Settings\kgrillot\Desktop\Sample Files\Good8268 txt Browse Upload File |

@ TextFile ¢ XML File

[Uploaded Batch Information

Begin Date |Tue Feb 12, 2008 End Date |Thu Mar 13, 2008 Retrieve Batch List |

Once the batch file has been successfully uploaded to KAN-DIS, you will see the following screen. You
should see a message indicating that the upload is complete and contains no errors as shown below in
green. Clicking on the Details button will allow you to view details on the batch file you just uploaded
as shown below in red.

I Browse... Upload File |
¥ TextFile © XMLFile
Upload Complete/No Errors
[Uploaded Batch Information |
Begin Date |Tue Feb 12, 2008 End Date [Thu Mar 13, 2008 Retrieve Batch List |
Upload 1D Uploaded - Total /{Correct/Errored Status Fatal Error
‘ Errors | 762 03/13/2008 30/30/0 END
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Step 4: Check the status of the batch file.

Click on the Details button. The details of the batch file will appear above the list of uploaded batch
files. The batch file that has the details displayed will appear highlighted in red in the list of uploaded
batch files. Notice that each batch file uploaded is assigned an upload ID number. If there are no
errors in the batch file, the Errors button will be grayed out. If the batch file contains errors, the
Errors button will be red. For instructions on correcting import errors, see the Correcting Errors in
Import section of this document.

I Browse... Upload File
I " TextFile & XML File
[Upload Batch Details
mmmmmlp- | Upioad ID 762
File Name CoodB268.twt
Extract Date 12/13/2007
Extract Time 15:31:18
Version 10 Each batch file is
;rans:'liésiorllD ;’;51:233 assigned an
eCor oun
Error Count O Upload ID number.
Upload Date 3/13/2008 10:09:40 AM /
[Uploaded Batch Information /
Begin Date |Tue Feb 12, 2008 End Date [} «far 13, 2008 Retrieve Batch List
Total /{Correct/Errored Fatal Error
Details | Errors | 03/13/2008 102/102/0

If the batch file contains any errors, this error

button will appear in red. Here you will see how many total data

To correct import errors in KAN-DIS, see the fields were successfully uploaded and how
Correcting Errors in Import section of this many had errors. o
document. Note: These numbers do not indicate how

many total incidents were uploaded.

You can check the incidents imported in the batch file by returning to “My Incidents.”

——

File ® Wiewr OCptions ¥ Helpk
@Mylncidents

éﬂh‘lv Reports
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This is how the incidents will appear once they have been successfully uploaded via a batch file. There
is no difference in the appearance between incidents that have been uploaded and those created in
KAN-DIS.

1 New |} i Click here to select a year: 2008 : 51 search
Drag a column header here to group by that column
0 = ! Incident Title Date School Year Date Created Created By
éﬂ [T 1% assault 09/27/2007 2008 03/13/2008 10:09 TesterDl
33 5 Halloween 10/31/2007 2008 03/13/2008 10:09 Tester01
& M %orugs 11/21/2007 2008 03/13/2008 10:09 Tester01
B 5 erought 11/26/2007 2008 03/13/2008 10:09 Tester01
éﬂ [~ ¥ Fight 11/28/2007 2008 03/13/2008 10:09 TesterDl
33 5 Fight in haliway 2 01/25/2008 2008 03/13/2008 10:10 Tester01
B Bright in halway 01/25/2008 2008 03/13/2008 10:10 Tester01

To view a particular incident, double-click anywhere on the incident line to view an Incident
Summary Report. Depending upon user’s level of access, they can now edit the incident. For
instructions on editing an individual incident, see the process for entering a new incident in Method 1:
Individual Incident Entry of this document. Correcting Errors in Incident Import

When uploading a batch file in KAN-DIS, two types of errors can occur. The first error type is known
as a fatal error. A fatal error is an error that prevents the entire file from being uploaded into KAN-
DIS. The second type is an error within a particular incident. This type of error prevents only the
incident with the error from being uploaded. Please note: both of the following sets of instructions
pertain to text files only. Any import errors resulting from an XML file should be addressed in the
SIS that created the XML file.

Fatal Errors in a Text File

After uploading a batch file using a text file, there is a fatal error indicated by the screen below. This
means that no part of the file successfully uploaded to KAN-DIS. Notice the error message in this
example indicates that there was a problem in the trailer record of the text file.

| Browse. | _ UploadFile |
I_G'Text File 7 XML Filel
——
/ \
< There was a fatal error: The Trailer record type passed was ST instead of TT. >

[ —— /

[Uploaded Batch Information |

Begin Date |Sat Feb 16, 2008 End Date |Mon Mar 17, 2008 Retrieve Batch List

IQ[;RM Uploaded « | Total/Correct/Errored | Status | Fatal Error
Details ||| Errors [[FEE] 03/17/2008 0/0/0 Foapert || I Ty SEETHE B CESs s ST MR

To correct this type of error, you will need to open the text file and correct the trailer, however if the
header and trailer are generated by your SIS, then notify your SIS vendor about the problem. The
correction has been made in the trailer row highlighted below.
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T T Ll 1) T
B Location Classifier GroupB8268.txt - Notepad
File Edit Format Wiew Help
TH 12/13/2007 15:31:18 Test233 1.0 Delimiter=0X09
I Do499 8268 Hallway fight 56428505214 11/28/2007 13:15:00 1
T 1000 1030
[o] 1 7837937171 jms offender .
N 230 5 In the trailer row, ST has now been corrected
v 1 6834068511 3 Hospi{ t0 TT. Save the text file and upload the batch
I D0499  B268 Ex student with gun fil H
T 1200 1210 1le again.
[e] 1 5937980905 Police
A 730 Sent to police to hav
\4 3 1
I D0499 8268 Reporter at school 11/21/2007 15:00:00
T 2300 2330
[o] 1 8523537228
A 650
U 3 1
I D0499 8268 valentine's 82375135432 10/31/2007 14:00:00
T 9999 Students veballs in the cafeteria salad bar.
[o] 4755747589 2 2
[e] 1 3985945225 2 1 1
A 180
A 180
I D0499 8268 Tudent ran over student 4266891051 9,/27 /2007 1
T offender struck teacher in the face and head with a chair.
[o] 060454 999 Classroom chair 2 1
A referred to olathe PD
A Transferred to juvenile detention facility
\4 3 Teacher was treated for concussion, multiple lace
mEliTesT233 30

Incident Errors in a Text File

When uploading a batch file, an error may occur that prevents one or more of the incidents from
being uploaded into KAN-DIS. When this occurs, you will see the following screen. On this screen you
will notice the Errors button text now appears in red.

| Browse... Upload File |

% Text File " XML File

1 record was in error.

[Records in Error | Download to Excel |

View Messages Errors Line Data
Viewl 2 3 T1111 1030

[Uploaded Batch Information |

Retrieve Batch List

Begin Date |Sat Feb 16, 2008

End Date [Mon Mar 17, 2008

Uploaded » | Total/Correct/Errored | Status | Fatal Error

03/17/2008 30/28/2

Detail

03172008 INI2RID EMDY
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Clicking on the Errors button shown above will allow you to view the line location information on the
error. Click on the View button shown below to see the error message.

Records in Error | Download to Excel |

Shee Errors | Line | Data

Messages

| 00499 8268 assault on Security guard 496789351 9727 /2007 10:00:00 100 120 During history

‘ View > L e class 100 101 In Mr. Norton's classroom

IUploaded Batch Information

Begin Date [Sat Feb 16, 2008 End Date [Mon Mar 17, 2008 Retrieve Batch List |

Upload

D Uploaded - | Total/Correct/Errored | Status | Fatal Error

Clicking on the View button will open the error message. In this example shown below in blue, the
School Year on the incident was left blank. To correct this error, the best practice is to return to the
SIS that created the text file and correct the data before attempting to re-import the incident. It is
recommended to import only the incidents that contained errors and had to be corrected to avoid
importing the entire batch file again. However, if your SIS will not accommodate this best practice,
you may submit the entire batch file to KAN-DIS again as long as you are utilizing a Local Incident ID
number (See the KAN-DIS File Specifications document.) to ensure that incidents uploaded multiple
times are aggregated properly. In the event an incident is uploaded multiple times, the data most
recently imported and subsequently approved will be retained.

Browse... | Upload File

¥ Text File " XML File

Download to Excel

View
Messages

| D0499 8268 assault on Security guard 496789351 9/27 /2007 10:00:00 100 120 During history
class 100 101 In Mr. Norton's classroom

[Uploaded Batch Information
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On this screen you also have the option of downloading the error message to Excel by clicking on the
Download to Excel button shown above in red. This opens the error message in Excel.

E Microsoft Bxcel - KanDis20080317[1]xls

@_] File Edit Wew Insert Format Tools Data Window Live Meeting Help

jJH_é_ﬂ'j_l?ﬂ& # BRI "'ﬁaz'%lillﬂ—'\l}l@ EAriaI

eSnagIt &' | Window - B
E Meet Mow ﬁ User Preferences... | Live Meeting Help + B
Al - & Line Number
A B C D
1 |Line Number Line Messagel(s)

| DO499 8268 assault on Security guard
496789351 9/27/2007 10:00:00 100 120

Dwring history class 100 101 In Mr. [496789351] School Year must have a non-
2 24[MNorton's classroom blank value.
3
4

Approval Process for Individual Incidents

A. Setting Approval Preferences (District Administrative Users Only)

To set school or district specific preferences, open the Options menu and select Approval Processing
shown below. Note: Only those with district level administrative access will be able to edit

preferences.

File» Viewr Opticns®» Help#

My Incidents Tt e - .
. ) 8 approval Processing New |i|.2
1= \"n..,_':’,‘\-.' Incide Sl TILTI LT
LA In Progress Drag a column heade
=] Pending School Approval
a O [[= ! |ncident T

L.5] Pending District Approval
& Approved
-I j&l state Repaorting
1 MCLE Discipline Report
&) Deleted ltems

I_'._.!_
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Clicking on Approval Processing will open the District Approval Setting page shown below.

District Approval Settings

The following is a list of the current approval process setup for your district.

If you would like to make changes, click Edit.

Setting Value Setting Description
True Is individual incident approval required at the District level?
School Administrator ‘When data entry is complete, should individual incidents be escalated to the School

Administrator or the District Administrator?

False Can an individual school see incidents from other schools within the district?

!!g Can Data Entry users see incidents that have been sent to Admin for approval?

Click on Edit to make any changes to the default approval settings.

This page allows you to make changes to the approval workflow for the entire district. The user can
make changes by placing or removing checkmarks in the boxes shown below in green or by using the
drop down box to select School or District Administrator shown below highlighted in blue. Clicking
save will update your changes to the district approval settings. Clicking cancel will not save any

changes to the district approval settings. An explanation for each of the four setting descriptions
appears below.

District Approval Settings

You can use this section to edit the approval settings for your district.

Click Update to save new changes. Click Cancel to revert the most recent changes without saving.

ing Value Setting Description

Is individual incident approval required at the District level?

When data entry is complete, should individual incidents be escalated to the School
Administrator or the District Administrator?

School Administrator i
Il Can an individual school see incidents from other schools within the district?

I Can Data Entry users see incidents that have been sent to Admin for approval?

Save, Cancel l\

Clicking here will not save any
changes made to the district
approval settings.

Clicking here will save any changes to
the district approval settings.
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1. Is individual incident approval required at the District Level? — This option lets you
determine whether a district-level administrator needs to approve individual incidents before
they can be used for a school’s NCLB and IDEA reporting. Placing a check in the box means
District-level approval IS required.

2. When data entry is complete, should individual incidents be escalated to the
School Administrator or the District Administrator? — If you placed a check in the box
for the first option, you can choose to either have incidents escalate from In Progress to the
School Administrator for approval and then to the District Administrator for approval, or
directly to the District Administrator for approval without review by the School Administrator.

3. Can an individual school see incidents from other schools within the district? —
Placing a check in the box for this item would let each school see (but not edit) incidents from
any school in their district when running searches on students and other criteria.

4. Can Data Entry users see incidents that have been sent to Admin for approval? —
Placing a check in this box will allow Data Entry users to continue to view incidents after then

have marked them to be approved. Leaving the box unchecked means once a Data Entry user
has sent an incident for approval, they can no longer access that incident.

After saving changes made to the district approval settings, the District Approval Settings screen will
appear again. Check to make sure all of the settings values are correct. To exit out of this screen you

can yse themenu bar indicated below in red.

< File ¥  View® Options b Help b > Click here for session informaj
Approval Process Setup District Approval Settings
This section of KanDis will allowyou to
make changes to the approval workflow for
your entire district.
The following is a list of the current approval process setup for your district.
If you would like to make changes, click Edit.
Setting Value Setting Description
True Is individual incident approwval required at the District level?
- ‘When data entry is complete, should individual incidents be escalated to the School
school Administrator Administrator or the District Administrator?
False Can an individual school see incidents from other schools within the district?
True Can Data Entry users see incidents that have been sent to Admin for approval?
Edit |
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B. Submitting an Incident for Approval

Before submitting any incidents for approval, read the following:

If you are a first time, data entry level user on either the school or district level, check with your school
and district administrators that all of the necessary approval settings have been set before you submit
any incidents for approval.

Note: Submitting incidents before the approval settings are in place will affect your
ability to successfully submit and track incidents in KAN-DIS.

Administrator level users only: For more information on how to set approval settings see the Setting
Approval Preferences section of this document.

To submit an incident for school level approval, first you will need to select the incident you wish to
submit by placing a checkmark in the box to the left of the incident’s title shown below in blue. Click
on the Send button to access a drop down menu. Here you may choose to send ALL or SELECTED.
Clicking ALL will send all of the incidents in your “My Incidents” window pane for school approval
except any that are red-flagged due to errors. Clicking SELECTED will only send the incidents you
have selected with a checkmark. This is shown below in red.

El:lllcal_innT_/

My User Name: TesterlS My User Type: SchoolAdministrator My District 1Dz D049% My Building 1D: 8268 - Spring Grove Primary Center

File» \View® Options® Help b

My Incidents " . = R . -
. New |2l Remoy, = | : Click here to select a year: 2009 } | L3l Search

| € Incidents - Tester19 Al
L7 In Progress Drag a column headf here| lu
[i3| Pending School Approval 0= i Selected
Lﬂ Pending District Approval * Incident itle None Dat: School Year Date Created Created By
ii Approved =N Drugs foulglin locker ogfoa /2008 2009 08/25,/2008 03:30 Testerld
3 Deleted items = [T ¥ Bullying in parki 08/08/2008 2009 08/25/2008 03:32 Tester1d

Food fight 08/11/2008 2009 08/25/2008 03:29 Testerls
Cafeteria Vandalism 08/13/2008 2009 08/25,/2008 03:28 Testerld
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You may check to see that the incident you selected has been submitted for school approval by
clicking on the Pending School Approval or the Pending District Approval folder.

File » VWiewFr OptionsF Helpk

My Incidents

=| #5% Incidents - Tester05
L7 In Progress
L2 Pending School Approval
L4 Pending District Approval
< Approved
~| 4 state Reporting
[ WCLE Discipline Report
{a] Deleted Iltems

v ]

Below you can see the incident submitted for school approval highlighted in blue. To the left of the
box you will see a green report button, circled in red below. Clicking on the green report button will
allow you to view an Incident Report for that incident. Only authorized users will be able to edit or
revise an incident once it has been submitted for approval.

My User Type: SchooclAdministrator My District 1D: D0499 My Building ID: 3268 - Spring Crove Primary Center

] New | ! Click here to selectayear: 2009 : | [ Search

Drag a coelumn header here to group by that column

O = | ! Incident Title Date School Year Date Created Created By
;SH Il Drugs found in locker 08/04 /2008 2009 08/25/2008 03:30 Testerl9
;SH Il Can you see me? 08/11/2008 2009 08/13/2008 02:50 Tester01

Cafeteria WVandalism 08/13/2008 2009 08/25/2008 03:28 Tester19

C. Approving an Incident

Depending on the individual school and district preferences for a school, the user may not have access
to all user levels of KAN-DIS. Some schools are not required to have district approval and would not
need to submit incidents beyond the school level. For further instructions regarding the various user
levels in KAN-DIS, see the User Level definitions page in the Terms and Definitions section of this
document.

School Administrator Level
When a school administrator level user logs into KAN-DIS, they have the ability to edit an incident,

return an incident to the data entry level, or approve the incident. Approving an incident sends the
incident to the district level if district level approval is required. The user approves an incident by
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placing a checkmark to the left of the title of the incident and clicking on the Approve button and
choosing ALL or SELECTED. The incident selected will be sent to the next level of approval or if the
user is the last to approve the incident, the incident will be moved to the Approved folder.

Return || & Appror = | § g

All

by the
|
54

Mone
o927 rEnay 2

10/31/2007 2

1122912007 2

On the school administrator level, the user can return incidents to the data entry level by placing a
checkmark in the box to the left of the title of the incident and clicking on the Return button and
choosing ALL or SELECTED. The incidents selected will return to the In Progress folder to wait
editing.

Educa!inn__/

My User Name: Tester24 My User Type: DistrictAdministrator My District ID: D0499 My Building ID: 8268 - Spring Grove Primary Center

File® View* Options* Helph

My Incidents . =
N : Click here to select ayear: 2009 : | (] Search
=l @3 Incidents - Tester24
L4 In Progress der here to grouf) by that column
[[5 Pending School Approva

[.3) Pending District Approva Date 5chool Year Date Created Created By
2 Approved - in laefer 08/04/2008 2009 08/25/2008 03:30 Tester19

\a) Deleted ltems

E 53 v Can you see me? 08/11/2008 2009 08/13/2008 02:50 Tester01

a
;SH I_ Cafeteria Vandalism 08/13/2008 2008 08/25/2008 03:28 Testerl9

The school administrator can either edit the incident directly using the steps outlined previously, or
have the data entry level user edit and resubmit the incident for approval. If district level approval is
not required, approving an incident at the school administrator level moves the incident to the
approved folder and the incident can no longer be edited. Only incidents appearing in the approved
folder will populate into the NCLB/IDEA aggregate reports.

File »  Viewr Opticns *  Help ¥

My Incidents

- 86t Incidents - Tester19
L# In Progress
L= Pending School Approval
L= Pending District Approval
A Approved >
~I &l state Reporting
[ NCLE Discipline Report
() Deleted ltems

5]

53 | Kansas Discipline Incident System Version 2.0



District Administrator Level

If district level approval is required, approving an incident on the school administrator level submits
the incident for district approval. On the district level, the approval process is the same as that for a
school administrator level. Any incident can be returned or approved. Incidents approved at the
district level are moved to the Approved folder. Incidents returned are moved to the In Progress
folder. District Administrative users cannot edit incidents.

Depending upon the approval settings for each school/district, the approval
process may differ from the images and basic process outlined here. For more

information regarding approval settings, see the Setting Approval Preferences
section of this document.
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Appendices

KAN-DIS Help Resources

KAN-DIS Project Website: The KAN-DIS website (www.ksde.org/kandis ) contains documents,
definitions, and FAQs related to KAN-DIS. The website also contains a schedule for the KAN-DIS
conference calls where announcements are shared and users can ask any KAN-DIS related questions.

KAN-DIS Listserv: Once you have been approved for access to the application, you will be added to
the KAN-DIS email listserv and you will receive important updates regarding KAN-DIS.

KAN-DIS FAQs: Questions about KAN-DIS may be directed to the email account: kandis@ksde.org.

KSDE Help Desk: If you are working in the application and are encountering a problem with the
software application, you can call our KSDE Help Desk at 785-296-7935.
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West's Kansas Statutes Annotated Currentness
Chapter 72. Schools
& Article 89B. School Safety and Security Act
- 72-89bo03. Information regarding identity of specified pupils, disclosure
requirements; criminal acts, reports to law enforcement agencies and state board
of education; school safety and security policies, availability; civil liability,
immunity

(a) If a school employee has information that a pupil is a pupil to whom the provisions of this
subsection apply, the school employee shall report such information and identify the pupil to the
superintendent of schools. The superintendent of schools shall investigate the matter and, upon
determining that the identified pupil is a pupil to whom the provisions of this subsection apply, shall
provide the reported information and identify the pupil to all school employees who are directly
involved or likely to be directly involved in teaching or providing other school related services to the
pupil. The provisions of this subsection apply to:

(1) Any pupil who has been expelled for the reason provided by subsection (c¢) of K.S.A. 72-8901, and
amendments thereto, for conduct which endangers the safety of others;

(2) any pupil who has been expelled for the reason provided by subsection (d) of K.S.A. 72-8901,
and amendments thereto;

(3) any pupil who has been expelled under a policy adopted pursuant to K.S.A. 72-89a02, and
amendments thereto;

(4) any pupil who has been adjudged to be a juvenile offender and whose offense, if committed by an
adult, would constitute a felony under the laws of Kansas or the state where the offense was
committed, except any pupil adjudicated as a juvenile offender for a felony theft offense involving no
direct threat to human life; and

(5) any pupil who has been tried and convicted as an adult of any felony, except any pupil convicted
of a felony theft crime involving no direct threat to human life.

A school employee and the superintendent of schools shall not be required to report information
concerning a pupil specified in this subsection if the expulsion, adjudication as a juvenile offender or
conviction of a felony occurred more than 365 days prior to the school employee's report to the
superintendent of schools.

(b) Each board of education shall adopt a policy that includes:
(1) A requirement that an immediate report be made to the appropriate state or local law
enforcement agency by or on behalf of any school employee who knows or has reason to believe that
an act has been committed at school, on school property, or at a school supervised activity and that
the act involved conduct which constitutes the commission of a felony or misdemeanor or which
involves the possession, use or disposal of explosives, firearms or other weapons; and

(2) the procedures for making such a report.

(c) School employees shall not be subject to the provisions of subsection (b) of K.S.A. 72-89bo4 and
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amendments thereto if:
(1) They follow the procedures from a policy adopted pursuant to the provisions of subsection (b); or
(2) their board of education fails to adopt such policy.

(d) Each board of education shall annually compile and report to the state board of education at least
the following information relating to school safety and security: The types and frequency of criminal
acts that are required to be reported pursuant to the provisions of subsection (b), disaggregated by
occurrences at school, on school property and at school supervised activities. The report shall be
incorporated into and become part of the current report required under the quality performance
accreditation system.

(e) Each board of education shall make available to pupils and their parents, to school employees and,
upon request, to others, district policies and reports concerning school safety and security, except that
the provisions of this subsection shall not apply to reports made by a superintendent of schools and
school employees pursuant to subsection (a).

(f) Nothing in this section shall be construed or operate in any manner so as to prevent any school
employee from reporting criminal acts to school officials and to appropriate state and local law
enforcement agencies.

(g) The state board of education shall extract the information relating to school safety and security
from the quality performance accreditation report and transmit the information to the governor, the
legislature, the attorney general, the secretary of health and environment, the secretary of social and
rehabilitation services and the commissioner of juvenile justice.

(h) No board of education, member of any such board, superintendent of schools or school employee
shall be liable for damages in a civil action resulting from a person's good faith acts or omissions in
complying with the requirements or provisions of the Kansas school safety and security act.
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